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Introduction 
 

 
This document was written to be used as a printed 
booklet. You are strongly recommended to refer to a 
paper copy, rather than trying to learn the features 
described while you are reading it online. 

Excel is the leading spreadsheet software for Windows. An electronic 
spreadsheet makes any work involving rows or columns of numbers 
much easier. As soon as you change any numbers on your 
spreadsheet, calculations which use those numbers  will be 
automatically updated. You can apply your own formulae or select 
from Excel's wide range of built-in functions. You can generate 
charts in a variety of formats from data in an Excel spreadsheet, and 
your chart will automatically update when you change your 
spreadsheet data. Excel also provides the tools for simple database-
style work with lists, but Access offers much more sophisticated 
tools for handling and querying databases. 

This document sets out to provide the information which 
is most commonly needed by people who are using Excel 
in an academic or office context. It assumes that you are 
familiar with the Windows interface, and with basics such as opening 
and saving files. You'll find it much easier to learn Excel if you are 
acquainted with using Word before moving on to spreadsheet work. 
Microsoft have designed all the Office applications so that they are 
as similar as possible. Common menu items will be found in the 
same place; text and data are for the most part edited, cut and pasted 
in the same way. 

These instructions are based on the Excel 2002 user interface. Excel 
2003 is identical as far as the features described here are concerned. 
If you have an earlier version, for most purposes there are no 
compelling reasons to upgrade to Excel 2003 if you already have 
Excel 97,2000 or 2002 on your home computer. Files can be moved 
between all versions of Excel from 97-2003 without conversion.  

Where things are different in the Excel 97 and 2002/3 versions, this 
is flagged in the course of the document. Margin notes are used to 
highlight significant Excel 97 differences. Excel 2000 is like 97 in 
some respects and like 2002 in others. 

Excel 2002/3 files can be moved to and from Excel 97 
or 2000 without requiring any conversion, but if you have 
used any features which were new to Excel 2002/3 they will not 
be honoured when you open the file in earlier versions. 



 

Basic operations 
 Load Excel. 

When Excel has loaded, it automatically opens a new workbook, 
with a worksheet open ready for you to use. In Excel 2002/3, you'll 
also see that the Task Pane has opened at the right of the screen. 
This was a much-proclaimed new feature in the 2002 versions of 
Microsoft Office software. But in Excel, it only has limited functions. 
Close it, and the worksheet view will expand to the full size of the 
Excel window. 

 

The Task 
Pane when 
you start up 
Excel. If it's 
open when 
you don't 
need it, close 
it from the X 
top right of 
the pane. 
Open it from 
the View 
menu. 

Any Excel file is a workbook. Think of this as an “electronic ring 
binder” where related worksheets are filed together. The worksheet is 
like a massive piece of paper where you can set out your work. You 
can have different spreadsheets and charts on different worksheets or 
on different parts of the same worksheet, as you prefer. You only see 
a small part of the available worksheet area on screen. 

 Familiarise yourself with the menu, toolbar, and window 
controls at the top of the screen. On your own computer, the 
toolbars you see may not be exactly as illustrated below – they 
can be customised to suit different users' preferences. 

4 Basic operations 

 Move the cursor slowly over the toolbar buttons. A yellow tool 
tips box pops up to describe the function of the tool which the 
cursor is currently resting on. 

 In Excel 2000-2003, there is a separate icon in the Taskbar at 
the bottom of the screen for each workbook you have open. 

The worksheet is divided into rows and columns: each box formed 
by this grid is called a cell. To enter data in a cell, you select the cell 
by clicking in it. The active cell is the one you have currently 
selected. It will be surrounded by a thick black border. The cell 
reference consists of its column and row address: for instance, A1.  

The sheet tabs at the bottom of the window let you move quickly 
from one worksheet to another within your current workbook. For 
easier reference, you can give each worksheet within your workbook 
file any name you want. Beneath this, the status bar often provides 
useful information relating to your current action. 

Title bar – shows name of file 
you're working in. 

Excel minimise button – reduces your Excel file to an icon in the Taskbar at 
the bottom of the screen. Click there to bring Excel back to life. 

Menu bar Standard toolbar Formatting toolbar 

Excel close 
button – exits 
from Excel. 
File minimise/size/ 
close buttons – 
affect only the 
currently active 
workbook window 
within Excel. Formula bar 



 

Using Excel help 

Excel 2002/3 has an Ask a Question box at the top right of the 
screen. 

1. Type a question - or just a keyword - into the box, then press 
enter. A list of topics will appear.  

2. Select a topic, and the Excel Help window will open, with 
information on the selected topic displayed. Click on any blue 
text to display further information about that sub-topic. 

In earlier versions of Excel, use the Help menu to access this window. 

3. Notice the three tabs at the top left of the Help window. 
Answer Wizard and Index provide two different ways in to 
the same help which is available from the Ask a Question box. 
Generally, it's quickest to use the Index if you're familiar with 
Excel terminology, whilst the Answer Wizard is more likely to 
locate the help you need when you don't know the jargon. 

4. Contents Help offers tutorial-type help on specific topics. 
Click the Contents tab, then click the + symbol to expand the 
list.  

Managing your files 

 Save your file as soon as you start work. An Excel file 
will automatically have the extension ".XLS" added to the 
name you give. Keep filenames short and meaningful. 

 Save your work every few minutes. Otherwise, you run 
the risk of losing your work if the system crashes. 

 It's essential that you're clear about where you are 
saving your work to. If you're working on a networked 
PC,, it's generally best to work from your network homespace. 
Most especially with large spreadsheets or spreadsheets 
containing a lot of charts, working from floppy disk, or a USB 
storage device with only limited space, should be avoided. 

 When a file has been created in other software, its 
name may not be visible in the Open dialog box. To display 
the file: Under Files of Type, select All Files (*.*). 

 If you want to take a file to a different computer which 
runs a version of Excel earlier than Excel 
97, or other spreadsheet software, you must save in 
the correct format. In the Save As dialog box, 
click on the arrow to the right of Save File as 
Type, and select the format you want. 

 You can have more than one Excel file open at the 
same time. In Excel 2000 and later versions, click on the 
Taskbar icons(bottom of the desktop) to move between them. 

It can be confusing to have multiple files open – 
always close files if you aren't using them.  

"Windows in Taskbar" (below) 
were introduced in Office 2000. 
Excel 97: move between open files 
from the Excel Window menu. 
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Entering your Data 
A Trial Run 

Warning 1: for a very 
simple spreadsheet like 
this, it's OK to leave 
blank rows or columns 
between data. But if you 
want to create charts 
from your data or use 
complex formulae, blank 
rows or columns should 
always be avoided. 

 If cell A1 isn't surrounded by a thick border, click in it to 
make it the Active Cell. Type in the following heading: 
THE SIZE OF AN EXCEL WORKSHEET 

Accept or clear active cell entry Formula Bar 

All of this text is contained in the Active Cell, even though on 
screen it overflows into the neighbouring cells. 

 What you're typing will be displayed in the Formula Bar as 
well as in the Active Cell. Use the delete and backspace keys 
to correct mistakes as in a word processor.  

 To accept your cell entry, either press Enter; use the tab key; 
or click the tick  by the Formula Bar. 

Now type in the rest of this little table to look like the example on the 
left, but don’t type anything in cell C6 yet.  The Formula Bar displays the 

formula you have entered. 

Once you've pressed Enter or clicked the Tick, the 
Active Cell displays the result of your formula. 

 Use tab; the arrow keys; or click with the mouse, 
to go to the next cell you want to enter data in.  

In cell C6, you need to enter a formula – you want 
Excel to calculate the number of rows multiplied by the 
number of columns. This is entered as: =C3*C4 

 Always begin a formula with the = sign. 
 Use * for multiplication, / for division. You can enter 

these characters, as well as numbers, either from the 
main keyboard or from the numbers pad on the right. 

Warning 2: when you're 
entering simple data, it's 
fine to click with the 
mouse or use the 
keyboard arrow keys to 
move from one cell to 
another. But with 
formulae and functions, 
always confirm before 
moving to another cell - 
press Enter or click the 
Formula Bar Tick first. 

 In Excel 2002/3, you'll notice that any cells referred to in your 
formula appear with a coloured border. You can click and 
drag this border to another cell or cells, and your formula will 
update automatically to specify the new cell address. 

 Press Enter or click on the tick  to confirm your formula. 
Read the warning note in the margin! 

You now know how many millions of cells are available in an Excel 
worksheet. But worksheets are much easier to handle if you keep to a 
fairly small area. If you have a lot of different but related items to 
include, arrange them on different worksheets within your workbook. 

Undoing and redoing 

 Don't forget how useful the Toolbar Undo and Redo 
buttons are in all Office software. Excel lets you undo 
multiple actions, not just your last action. 
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Data Entry Shortcuts: the Auto-Fill feature 

Excel does everything it can to make data entry as quick and easy as 
possible. Try one of Excel's nicest features to see how intelligent it 
can be. 

 Type into cell A10: MONDAY 

Cell Handle 

Autofill cursor 

 If necessary, click in A10 to make it the active cell. 

 Look at the bottom right corner of the active cell border. The 
little square box is called the Cell Handle. When the mouse 
cursor is moved over the Cell Handle, it changes shape to + 

 While the mouse cursor is this shape, click with the left mouse 
button, then keep holding the mouse button down while you 
drag down over cells A11-A18. (Go further or not so far if 
you want.) Release the mouse button, and what you see should 
look like this picture. If it doesn't, try again. 

 Move into an empty area of your worksheet. Try using the 
Auto-Fill feature in the same way to enter months of the year 
instead of days of the week. 

When you want to use Auto-Fill for a sequence of numbers, you will 
need to type in two (or more) "example cells" to show Excel the 
logical sequence you want. 

 Move into an empty area of your worksheet. Type 1851 into 
a cell, then 1861 into the cell below. 

 Click and drag over these cells to select both of them 
together. They will share a common cell border and cell 
handle, as shown. 

In Excel 2002/3, the Autofill 
Options Button will appear 
whenever you use the Autofill 
feature. If what the Autofill has 
given you isn't what you 
wanted, click the arrow by the 
button to select from alternative 
options. The button disappears 
when you carry on working.  

 Drag on the cell handle to auto-fill the cells below these two 
dates. This should give you a column of ten-yearly intervals. 

 Auto-Fill can work along rows as well as down columns. This 
time type the number 0 into a cell, then type 50 into the cell to 
the right of it. Select both cells, then Auto-fill by dragging the 
cell handle across instead of down. 

 If you use Autofill with text that Excel doesn't 
recognise as the beginning of a series, your cell entry 
will be copied into all the cells you drag across. 

 You can create custom Autofills for any text entries 
you need to use frequently. You might do this for entering 
sets of row or column headings you commonly use. In Excel 
Online Help, use the Answer Wizard to search for Custom Fill 
Series. (Word 97: you'll find this from Index Help.) 
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Laying out and Formatting Data 

Universal DO’s and DON’Ts 

 Never split a single item of data between different 
cells. It doesn’t matter how long a heading is, for example –  
you can align and position the contents of the cell on the page 
exactly as you wish while still confining it to a single cell. 

 
Concentrate first on getting your data entered 
correctly. Don't get carried away at this stage with all the 
intricacies of formatting which are available in Excel.  

 As you get more familiar with Excel, you will find that there 
are other ways of doing things as well as the ones described 
here. Experiment! 

Creating an example Spreadsheet 
 Close any workbooks you have open, and open a new file. 

 Save it straight away – if you're following the example 
below, you might give the file a name like "Student_stats". 
Keep filenames as short as possible. (Generally it's a good 
habit to avoid spaces in filenames – they can cause problems 
in some contexts.) 

If you want to learn by following an example, type in the student 
numbers data so that it looks exactly as it does below. Type in the 
data first, then improve the layout and formatting. 

 The instructions you need to add formatting to your 
spreadsheet as shown below are on the next page. 

  Type the whole main heading into cell A1. After formatting the whole of column A as you 
require for your row headings, come back to adjust the heading format, then select cells 
A1:D1 and centre the heading across them. 

Left align column A and format bold 
italic. Do this before formatting the 

main spreadsheet heading. Otherwise, 
you'll lose the heading formatting if you 

then apply different settings to the 
whole of column A. Right align the column headings in B3:D3 to match the 

right alignment of the figures. 

Leaving a blank row between a 
main heading and the data is fine, 
but don't  leave blank rows within 

the body of your data. 

Increase the height of row 4 
to give some extra space 

after the column headings. 

Adjust all columns to 
appropriate widths. 
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Select, then Do 

Row 
address 

bar 

Column 
address 

bar 
The general rule when you want to format, change, move or use data 
is: Select, then Do. Selected items appear highlighted on screen, 
except for the active cell, which remains white even when selected. 

 To select just one cell: simply click in it. 
 To select a range of cells: click and drag over them. 
 To select an entire column or row: click on the row number or 

column letter in the address bar. 
 To select non-adjacent cells: hold down the Control key 

(bottom left of keyboard) while you click each one. Select All button 

 To select everything in the worksheet: click the Select All 
button in the top left corner of the address bars. 

Column and heading alignment 
Setting column alignment appropriately greatly improves appearance. 
Excel decides for you that numbers should be aligned right, and text 
should be aligned left. You'll often want to change this – in our 
example (page 8), the column headings look better aligned right. 

Left 
Align Centre 

Right 
Align  Select the cells you want to realign. 

 Click on the appropriate Toolbar button. 
To centre a main heading: 

 Type the heading into a single cell. 
 Click and drag to select the cells which you want your heading 

centred across. (Cells A1:D1 in our example.) 
 Click on the Merge and Centre toolbar button. 

Adjusting column width and row height 
Adjusting column width to suit your data will often be necessary. For 
instance, to change the width of column A: 

A tooltip will appear while 
you're dragging to show you 
what width you're setting. 

 Position your mouse cursor on the dividing line between A 
and B on the column address bar.  

When the cursor changes to a resize symbol ("double arrow" shape): 
 Click and drag until the column is the width you want.  

You will often want to adjust a column’s width after you have typed 
in data, to fit the longest entry. Excel can do this automatically:  Help: my figures 

have disappeared!! 
If your column isn't wide 
enough to fit any number 
contained in it, that 
number will be displayed 
as a set of hash symbols: 
######### 
When you adjust column 
width, the figures will be 
displayed properly again. 

 To autofit a single column: position the mouse cursor as above, 
then double-click when it changes to a resize symbol. 

 To autofit all columns: select the columns, making sure that 
any main headings which you want running across multiple 
columns aren't included in the selection. From the Format 
menu, select Column, then Autofit Selection. 

 To adjust row height – click and drag between address bars as 
for columns. Select all first if you want adjustments to apply 
to all rows in the spreadsheet. 
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Deleting, copying, inserting and moving cells 

To apply the most commonly used "cut and paste" commands, you 
can use the Edit menu or the Toolbar, as in Word. It's also worth 
being aware that you can use the right mouse button to access the 
editing and formatting commands you're most likely to need. 

Deleting data 
 To clear the contents of a cell or cells and leave them empty: 

select, then press the keyboard Delete key. If you enter 
new data into this cell, any formatting which you had 
previously set on the cell (bold, number format etc.) will be 
retained. 

 Where you want cells and not just their contents to be 
deleted:Select, then click on the right  mouse button. A 
shortcut menu should now appear. It may not be quite the 
same as the example: some menu items are context-sensitive. 

Note the difference in Cut, Delete and Clear Contents: 
 Cut in Excel is mainly used to move cells. See the next page. 

 Delete deletes full rows, columns, or selected cells, and 
moves the adjacent cells on the worksheet up or across into the 
vacated space. When you choose Delete from the menu, the 
Delete dialog box will pop up. Select the option you want. 

 Clear Contents blanks the selected cells, but leaves them in 
position – exactly like the keyboard delete key. 

Copying cells 

The shimmering box shows 
that Excel is waiting for you 
to specify where you want 
the selected data copied to. 

1. Select the cells you want to copy, then click the Toolbar Copy 
button. A shimmering box will appear around the selected cells. 

2. Click in the cell where you want the top left item in your 
copied block to be placed.  

3. Press Enter; or select Paste from the toolbar or right mouse 
shortcut menu. Press the Escape key to cancel your action.  

Using the Office Clipboard (Excel 2002/3) 
In all Office 2002/3 software, up to 24 items you have cut or copied 
can be stored at one time. The contents of the Office Clipboard are 
accessed from the Clipboard Task Pane.  The icon appears in the 

System Tray as soon as 
you have copied an item 
in any Office 2002/2003 
software. 

 To display the Task Pane: double-click the Office Clipboard 
icon in the System Tray at the bottom right of the desktop. 

 To paste an item from the Clipboard Task Pane to your 
spreadsheet: single-click on it. 

 You can use the Clipboard to copy and paste items between 
any Office software files you have open. 
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Inserting cells, rows and columns 

Sometimes you'll want to insert extra cells within an existing row or 
column – for example, if you've accidentally omitted an item when 
entering data, and need to add it in. On other occasions, you'll want 
to insert a full row or column, as in the illustration. When you insert 
cells, they will be placed above or to the left of the selected cells. 

 Click with the right mouse button in the cell below or right of 
where you want a new cell or cells inserted. Select Insert 
from the shortcut menu which appears. 

 Make the appropriate choices in the Insert dialog box. and 
OK. In Excel 2002/3, an Insert Options Button will now 
appear next to the inserted cells. If the cell formatting isn't as 
you want, click the button arrow to select alternatives. 
Otherwise, carry on working and the button will go away. 

Shortcut to insert a full row or column: 
 Click with the right mouse button on the address of the row 
below, or column to the right, of where you want the new one. 
This will select the row or column and bring up the shortcut 
menu at the same time. When you select Insert from the 
shortcut menu, a new row or column will automatically be 
inserted without needing to use a dialog box. 

Moving cells 

 If you want to move cells to a new position within 
your spreadsheet without replacing existing data, 
you'll first have to make the space to receive the data 
by inserting cells as described above. 

To move cells short distances, it's easiest to use drag and drop. 
 Select the cells you want to move, then point the mouse cursor 

at the border of the selection –  it will change from a white cross 
to a move cursor, as illustrated. (If you're using this document 
with Excel 97 or 2000, see the accompanying note.) Drag and drop will only work 

when the cursor changes to the 
move shape, as illustrated. 
(Note: the shape of the Excel 
move cursor was changed in 
the 2002 version to conform to 
the standard move tool used 
widely in Windows software. In 
earlier versions, you'll just see 
a white arrow.) 

 Click and drag to move the selected cells to their new 
position. 

 If you're using more than one worksheet in your workbook and 
want to move cells between them: hold down the Alt key 
while you drag. Drag over the worksheet tabs until the one 
you want is highlighted, then drop at the position you want. 

Drag and drop can be difficult if you're moving cells a long way 
across your worksheet – if so: 

 Select the cells you want to move. On the toolbar, click the 
Cut button. Or right-click with the mouse to select and bring 
up the shortcut menu all in one go, and choose Cut from there. 

 Now follow the same procedures as when copying (page 10) 
to paste the selected cells to a different position. 
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Using multiple worksheets 

It's often useful to organise your data on different worksheets 
within the same workbook file. For example, if you wanted to keep 
month-by-month accounts for the whole year in a single workbook, 
you could use one worksheet for each month. By setting up one 
worksheet to use as a template, you can easily apply consistent 
layout and formatting between worksheets. 

A new Excel file opens with three worksheets available. You can 
name and rename worksheets as you want; insert more worksheets; 
and shuffle around their order as you require. All this is done by 
clicking on the worksheet tabs at the bottom of the Excel window. 

Naming worksheets 

By default, worksheets are named Sheet 1, Sheet 2 etc. To supply 
names of your own: 

1. Double-click on the tab for the worksheet you want to rename. 

2. The name currently on the worksheet tab will be highlighted, 
waiting for you to type in your replacement. 

Deleting, inserting and reordering worksheets 
 To delete a worksheet: with the right mouse button, click the 

worksheet tab, then select Delete from the shortcut menu. 

 To insert a worksheet: With the right mouse button, click on 
the worksheet tab to the right of where you want a new one 
inserted. Select Insert from the shortcut menu. 

When you insert a new worksheet, it will be placed before the one 
currently selected. This is annoying if you want a new worksheet 
after all your existing ones: you will need to reorder worksheets. 

 Click on the tab for the worksheet you want to reposition. 

 Click and drag the tab to its new position. The black arrow 
above the tabs shows where the worksheet will be inserted. 

Viewing multiple worksheets 

 In the Window menu, click on New Window.  
 Return to the Window menu, and select Arrange. Select 

your arrange option. If you have more than one workbook file 
open but want to view only the worksheets within the active 
one, make sure Windows of active workbook is checked. 

 Add extra new windows for as many worksheets as you want 
to view simultaneously. 

 Select a different worksheet to view in each of your windows. 
Move, copy, paste etc. between them as required. 
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Changing your data’s appearance 

There are many things you can do in Excel to make your spreadsheet 
fit elegantly on the page. Headings can be set to run vertically; text 
can be "wrapped" to the column width. You can choose from a variety 
of number formats; and change your typeface or type size. 

Simple character formatting 

All Microsoft Office software is designed to be as similar as possible. 
Simple character formatting is done from the toolbar just as in Word. Select All button 

 If you want to change the typeface and/or size of all your data: 
use the Select All button and make these changes before 
formatting any headings differently. 

 To change font colour: select the cells. In the toolbar, click 
the arrow by the font colour tool, and choose your colour. 

 To give cells a coloured fill: select the cells. In the toolbar, 
click the arrow by the fill tool, and choose your colour. 

Arial Narrow is often a good choice of typeface for a 
spreadsheet, because of its compactness. 

10 pt is a good size for numbers to be legible but not too large. 

If you're moving files between computers, it's wise to 
stick to standard typefaces to avoid formatting changes if the 
typeface you have specified isn't available. Arial and Times are 
available on any computer running Windows. 

The Format Cells dialog box (see below) gives access to more 
sophisticated control over formatting text as well as numbers. 

Formatting numbers 
There are a variety of ways you may want to format numbers: with or 
without currency signs, decimal places, commas between 1,000s and 
so on. The commonest number formatting types can be applied to 
selected cells straight from the toolbar. These aren't on/off buttons – 
to reverse their effects, Undo straight away or Format Cells as below. 

Currency Commas 

Percent Decrease/increase 
decimal places 

A much wider range of formatting options is available from 
the Format Cells dialog box than from the toolbar: 

 Select the cells you want to format, then right-click. 

 In the Shortcut menu, select Format Cells. 

The Format Cells Dialog box will open. Make sure the 
Number tab is selected, and browse through the available 
formats and settings to find what you want. 
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Alignment: text wrap and orientation 

 
When you set wrap or orientation, settings will be 
applied to cells containing numbers as well as 
cells containing text. Make sure you haven’t 
selected entire columns when you only want the 
heading cells running vertically or at an angle. 

 Select the cells you want to format, then right-click 
on the mouse. Click Format Cells in the shortcut 
menu. 

 In the Format cells box, click the Alignment tab. 
 Click the Wrap Text checkbox if you want text in the 
selected cells to wrap to column width. 

 Change the Orientation setting if you want cell contents 
to run vertically or at an angle. Click and drag on the red 
marker or set the angle from the Degrees Box. Set at 90°, 
text or numbers will run upwards; set at -90°, they will 
run downwards. 

Adding borders and patterns 

By default, the grey gridlines you see on screen won't print out. You 
can change this by specifying show gridlines when you print (page 
30). For a wider choice of border options: 

 Select the cells, then click the arrow by the toolbar Borders 
button. Make your choice from the selection that pops up. 

Patterns and shading can be added from the Patterns tab in the 
Format Cells dialog box (see above). From the Borders tab, you 
get control over line width that isn't available from the toolbar button.  

Using AutoFormat 

 Select the spreadsheet area you want formatted. 

 Select Format from the Menu Bar, then 
AutoFormat. Use the scroll bar to view the full 
range of styles available. Use the Undo button 
straight away if you decide you don’t like the 
effects of the AutoFormatting. 

You can “pick and choose” which elements of an 
autoformat you want to use: 

 In the AutoFormat box, click on Options. 
 Set the Formats to Apply checkboxes as 

required. 

 Warning: "Not enough memory" problems may arise when 
using AutoFormat. This is especially likely if there are charts 
within the worksheet area you have selected for formatting. 
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Formulae and Functions 
This section gives you enough information to carry out basic 
operations such as calculating sums, percentages and averages. It 
doesn't cover specialist tasks in any depth. 

Functions are built-in formulae designed to make your work 
simpler and faster. A few of these –  SUM and AVERAGE in 
particular –  are useful to almost everybody. Many more functions 
are available for specialist use.  

A simple example: SUM 

You can use Autosum (page 16) or Insert Function (page 17) to 
do this, but it's useful to know how to set up a function from scratch. 

 Type in a column of around half a dozen numbers. 
 Click in the cell directly below these numbers to make it the 

Active Cell. This is where you want the result of your formula to 
appear. 

Now you're ready to try out the SUM function. Note: 
 As with all formulae,  begin with the = sign. 
 A function begins with the function name (in this case, SUM), 

followed by its arguments, contained in parentheses. You 
need to be familiar with the jargon, but don't be put off by it.  
"Parentheses" are brackets, and "arguments" are the data which the 
function is to work on. Another key word is syntax – the 
structuring rules which must be obeyed so that the function makes 
sense to Excel. In Excel 2002/3, the correct syntax is displayed 
under the formula bar as soon as you type a function name, as 
illustrated below. 

In this case, the function has just one argument: the range of cells 
you want to add up. To specify a range: 

The sum function 
can be used with 
any set of numbers 
or cell addresses, 
not just cell ranges 
– for example 
SUM(A2, B5, C7) 

 Type in the left bracket after the function name, then enter the 
first and last cell address to be included, with a colon : between 
the two.  
Or: On the worksheet, select the required range of cells. A 
shimmering line will appear around them. In Excel 2002/3, a 
coloured border will also appear round the cells. This can be 
moved or resized to modify the range of cells specified in your 
formula. 

 When the range is correct, add the closing bracket. 
 Press Enter or click on the tick in the Formula Bar, and the 

calculation is made. 

 
Once you have finished entering your formula, what 
you will see in the cell is the result, not the formula 
itself. See page 18 if you want your spreadsheet to display 
the formulae instead of the resulting data. 
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The AutoSum shortcut 
People want to total rows or columns of figures so often that Excel 
provides a toolbar button for you: 

 Click to place your Active Cell beneath a column of numbers, 
or to the right of a row of numbers. In the Toolbar, click on 
the AutoSum tool. 

 A shimmering line will appear around the cells which Excel 
assumes you would like added up. Click and drag with the 
mouse to alter this range if necessary. When the required 
range is selected, press Enter. 

Excel 2002/3 provides quick access to other commonly used functions 
from the Autosum tool. Click on the tool's pick arrow to select these. 
If you want more control over the range of cells to be summed, 
highlight the required range before clicking on AutoSum. You can 
sum a group of rows or columns if you want. 

Using AutoFill with formulae and functions 
All the columns or rows in your spreadsheet may need the same 
action applied to them: for instance, totalling or averaging. Use 
AutoFill (see page 7) to avoid having to enter formulae individually 
to apply to each row or column. Cell references will be automatically 
adjusted as Autofill copies the formula into adjacent cells. 

Relative and Absolute cell references In Excel 2002/3,an Options 
Button appears whenever you 
use Autofill. See page 5. When 
you're using Autofill with 
formulae, you won't normally 
want to change from the default 
Copy Cells option. Ignore the 
button and it will go away when 
you carry on working. Or, press 
the Escape key to get rid of it. 

When you use Autofill to copy a formula, it uses relative cell 
references. They are automatically adjusted for each row or column – 
for instance, when a reference to cell A1 is copied to the next cell 
across using autofill, it will refer to B1. Sometimes, though, you will 
want a cell reference to remain constant within a formula. For example, 
you may have a cell on your spreadsheet where the current chargeable 
rate of VAT is specified, and you always want your formulae to refer to 
this specific cell. This requires an absolute cell reference. 

The row and/or column address of a cell reference is 
made absolute when a dollar sign $ is placed in front 
of it, as you see in the Formula Bar here. Cell B1, 
where the current VAT rate is stored, is referred to as 
$B$1. If you use Autofill to copy a formula from a 
cell where a reference has been specified as absolute, 
this will carry through to all cells covered by the 
Autofill. 

To quickly change cell references within a formula from relative to 
absolute: in the Formula Bar, highlight the cell reference you want to 
change, then press F4. This will add in the $ sign. If more than one 
cell reference is highlighted, pressing F4 further times will cycle 
through all possible combinations of relative and absolute references. 

16 Formulae and Functions 



 

More about Formulae 

 
As in algebra, you use brackets (parentheses) to 
make Excel evaluate your formula in a particular 
order. So if you need to use any but the simplest formulae, 
you must understand why 
  = (A1+A2)*B1 
gives you a different result from: 
  = A1 + (A2*B1) 

 Always make sure that every bracket has its 
matching pair! 

 If you are getting unexpected results, try working out 
a simple example by hand. 

 It can be helpful to split complex formulae between 
two or more cells - this makes tracking errors easier. 

Two other arithmetic operators are available as well as the standard 
add (+), subtract(-), multiply(*) and divide(/): 

 percent (%) 
Use with multiply or divide. To calculate 30% of the number 
in cell A1, the formula would be: = A1*30% 
To calculate cell A1 as a percentage of cell A2, the formula 
would be: = A1/A2% 

 raise to the power of  –  exponentiation (^) 
Use Shift-6 on the keyboard for the exponentiation symbol ^ . 

Specialist functions  In Excel 97, the capabilities 
now described as Insert 
Function were referred to as 
Paste Function. The standard 
toolbar included a Paste 
Function tool for quick access.  

Excel 2002 introduced slightly different ways from previous versions 
of accessing specialist functions. To use a specialist function, or if 
you want to browse through the functions available: 

 From the Insert menu, select Function. 

The Insert Function box will appear. 
 Select the function type you want from the 
Function Category list, then select your 
function from the list. Information about the 
function is displayed at the bottom of the box. 

If you choose the Most Recently Used Function 
Category, you’ll find the most commonly used 
functions, including average, mimimum, maximum 
etc. (If you have Excel on your own computer, this 
list will automatically expand to include the 
functions which you use most commonly.) 
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IF Statements 

You will often want to make a calculation on 
data held in your spreadsheet only if certain 
conditions apply to it. In the example, the 

company director pays an efficiency bonus if staff manage to 
keep their overheads to less than £500 a year. Total overheads 
are given in cell B12. The amount to be paid will be £500 less 

the total overheads incurred. Nothing is paid if overheads total £500 
or more. The IF statement formula generates the value for cell B14. 

The useful syntax tip which 
is displayed as you type in 
your IF statement is a new 
feature in Excel 2002. 
Once you've entered your 
final bracket, the tip 
disappears. 

IF statements are always structured as follows: 

 =IF(condition,value if condition true,value if false) 
The condition in the example is "B12 is less than 500"; value if true 
is "500 minus B12"; value if false is zero.  

 Always make sure that the brackets and the comma 
separators are positioned correctly in your IF 
statement. And don’t forget that, like all formulae, 
an IF statement must begin with an = sign. 

 Excel Contents help provides extensive information 
about creating and correcting formulae of all kinds. 
In Excel 2002/3, it's under Creating and Correcting formulas. 

Displaying Formulae 

By default, the results of your formulae will be displayed in the 
spreadsheet cells, rather than the formulae themselves. You'll only be 
able to see formulae one at a time in the formula bar, when the cell to 
which it applies is active. It can often be useful to view all the 
formulae you're using on a spreadsheet at the same time. 
To quickly toggle between viewing formulae and data: 

 On the keyboard, press Ctrl + `  
(` is the grave accent key – top left of keyboard below Escape.) 

 Press the same keyboard combination to return to data view. 

For some purposes, you may want to change settings so that by 
default you view the formulae in your worksheet.  

 From the Tools menu, select Options. The Options dialog 
box will appear. Click on the View tab. Under Window 
options, click in the checkbox by Formulas. 

 Return to the Options box and switch the Formulas checkbox 
off again when you want to return to viewing the data. 

 The Options box is where you go to change a number 
of important Excel settings. On your own computer, 
changes made from here will remain in force until you change 
them again. On centrally-administered networked computers, 
standard settings may be restored every time Excel is loaded. 
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Organising data in lists 
A list is Excel’s word for a humble kind of database. Excel provides 
database-type features which can be used to order or sort data; and 
to extract or filter sets of data which meet particular criteria. 
Beware of treating the wrong kind of data as a list – for example, 
you could create havoc with a set of accounts by applying a sort. 

Designing your List 
Field names 

Records 

Above is a sample list. It is made up of a collection of Records, 
each held in a row of the Excel worksheet. Within the records, the 
data is systematically organised into Fields: thought always needs to 
be given to how this organisation should be done, for the particular 
set of data you are working with. Each field has a Field Name: keep 
these as short as possible, but meaningful. 

 
Think in advance about how you might want to 
sort the data in your list. 

Consider this advice in relation to the sample. It's important that you 
should appreciate why it's a good idea to divide people's names into 
separate Lastname and Firstname fields. (Rather than having one 
Name field and entering  names as "Anna Parker" and so on.) 

Entering data into a list 

There are two ways of entering data into your database list: 
1. Exactly as you would enter data into a spreadsheet. There is 

no fundamental difference between a spreadsheet and a list. 

2. By using Excel's Form facility, from the Data menu. This 
allows you to enter data in what can be an easier way, with 
one record displayed at a time. See page 20. 

For most purposes entering data in the usual spreadsheet way has no 
disadvantages. But where your list includes a large number of 
columns and involves a lot of scrolling across to enter data, you may 
find that using a form is better. Forms also provide an easy way to 
filter out records that meet specific conditions, or criteria; but if you 
want to view these filtered records all together in a table rather than 
one-by-one, you need to apply a filter from the menu instead. See the 
following pages. 
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Setting up lists: Do's and Don'ts 

Problems most commonly arise with lists because people haven't 
been careful enough at the data entry stage. 

 
Keep each list you create on its own separate 
worksheet. See page 12. Otherwise, Excel may become 
confused over what data items you want to be treated as part 
of a specific list, and what you don't. 

 
Don't leave any blank rows in your list – not even 
below column headings. When you sort, the blanks will 
end up all clustered together. If you use forms, they will 
completely screw up. Adjust row height to give extra space 
between records – see page 9. 

 Any spaces accidentally included at the beginning 
of a field entry will mess up attempts to order or 
extract data. It's essential when entering any data you want 
to sort, that you should do so carefully and consistently.  

 
All of Excel's formatting capabilities are used in just the same 
way with lists as with any other spreadsheet data. 

Using forms to enter data 
Excel refers to a row of 
headings as a header row. Before you can use a form, you need at least one sample row in your 

list. Excel will interpret what you want most satisfactorily if you 
have first set up your column headings in the top row of your list, set 
your column widths appropriately, and entered a sample record. 

 Click anywhere in your list. Make sure you 
haven't got multiple cells selected – for instance 
an entire row or column. Things won't work 
properly if you have. 

 From the Data menu, select Form. 

What you now see should look like the illustration. 

 Click on New to add another record to your list. 

 Use the Tab key, or click with the mouse, to 
move between fields. 

 Use the Scroll Bar, or Find Previous and 
Find Next, to move through your records. 

 Click on Criteria to filter out records meeting specific 
conditions. In the illustration, criteria have been set to pick out 
all entries whose age is less than 50 and who live in Sheffield. 

Excel provides plentiful online help for learning 
about its list handling features. In Excel 2002/3, type 
Lists in the Ask a Question box.  In Excel 97, from Help 
Contents, select Managing Lists.  
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Sorting data 

On many occasions, sorting is the quickest and simplest way to 
cluster together the data you're looking for: it often isn't necessary to 
worry about setting filters. You can use these tools with any data, not 
just database-type lists, but sorting isn't appropriate for all types of 
data. For a simple ascending or descending sort on one field: 

 Click anywhere within the column you want to sort on, and 
click the Sort Ascending or Sort Descending button. 

You may want to include a “sort within a sort”. If you had numerous 
Smiths in a list of names, you would like them sorted by Last name, 
and within that by First name. 

 Click on Data in the Menu Bar, then Sort. 
The Sort dialog box will now appear. In our example, you 
would select Lastname under Sort By, and Firstname under 
Then By. To specify the fields you want to sort by: 

 Click on the arrow next to the Sort By box, then select the 
name of the field you want. Set Ascending or Descending 
order as required. Do the same thing in the Then By boxes. 

 Make sure My list has is correctly set for Header row/No 
header row. If your top row is formatted differently from 
your data, Excel will automatically assume it's a header row. 

Filtering data 

Use the Autofilter feature to display only records from a worksheet 
which meet a specific set of conditions, or criteria –  for instance, 
all the sales made by one salesman. Operators you can use include 
those listed on the left. In addition to the standard "equals", "greater 
than" and so on, "begins with", "ends with" and "contains" operators 
are available. All operators can be used with either number or text 
data. 

1. Click anywhere within your list. 

2. From the Data menu, select Filter, then AutoFilter. 

Picklist arrows will appear by the top of each column. 
3. Click the arrow by the field you want to filter on. 

The picklist will show all the different values which have been 
entered in that field.  

4. Select Custom if you want to use “greater than”, 
“less than” etc. The example is set to filter records 
where Age is less than 50 and greater than 20. 

5. If you want to create a chart from a filtered list, copy 
the filtered data to another worksheet or another area 
of the current worksheet, and select it for charting 
from there. 

6. To show all your records again: from the Data menu 
select Filter, then Show All.  
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Creating Charts in Excel 
This section explains how to create charts using Excel's Chart 
Wizard tool. The example data used here is the student stats 
spreadsheet – if you want to follow these guidelines using this data, 
see page 9.  

 
Before you click the Chart Wizard tool, you should always 
stop and think. The Wizard can't do its job properly 
without your help. 

 
Plan out clearly what you want your chart to look 
like –  this will help you to make the appropriate selections 
from Chart Wizard. If your choices are inappropriate, it's 
quite possible to produce a chart which looks good but 
means little or nothing. 

 
Most charting problems arise because Excel can't 
make sense of the data you have selected from 
your spreadsheet. Be careful that you select the correct 
data from your spreadsheet for Chart Wizard to work with –  
all the required data, and only the required data. 

Basic concepts 

Chart Wizard needs two things to do its job properly: 
 Numbers for plotting. These will be contained in one or 

more rows or columns of your spreadsheet. Each row or 
column of numbers for plotting is known as a data series.  

 Text  (or numbers to be treated as text) for labels or "legends" 
–  the text which appears along the axis, and/or in a chart key.  

Usually, the column headings (the first row) of 
your selected data will contain the names of 
your data series, and will be used for the chart 
legend. The row headings (first column) will 
contain the labels for the x-axis - these are 
known as category labels. Chart Wizard will let 
you switch this round, if you want; or treat the 
first row and/or column as data instead of labels. 

YEAR TOTAL WOMEN MATURE 
1991    
1992    
1993    
1994    
1995    

In our example, we will want Chart Wizard to 
use the column headings for legend text, 

 and the row headings as category (x)axis 
labels. 

 
Excel will automatically generate the values needed for the y-
axis (value labels), from the range of numbers in your data. 

 If a row or column which you want to use as category labels 
consists of data which Excel thinks of as numbers rather than 
text, Chart Wizard may get in a muddle. In the example, this is 
going to happen because we want to use the Year column as 
category axis labels, not as  a data series. See the next page. 
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1. Plan where to place your chart 

Once you've created your chart, you'll be able to scale its size exactly 
as you want. You can place a chart on the same worksheet as your 
data – for instance, below or alongside it. Or, you can keep charts on 
separate worksheets within your worksheet book. Either way, your 
chart will be automatically updated if the data changes. If you plan to 
put charts alongside the data, if necessary rearrange any other data 
before you start so that the space is ready to receive it. 

2. Select your data for charting 

Chart Wizard works on the rows or columns which you select for 
charting. Bear in mind the following rules: 

 
If there's a heading at the top of your spreadsheet, 
don't select it as part of the data for plotting. Chart 
Wizard will prompt you to type in a title for your chart. 

 
Don't select blank rows or columns. Chart Wizard 
will treat the blanks as data for plotting, and you will not 
get a satisfactory chart. 

 Make sure the columns you select all extend over the 
same set of rows; and that the rows you select all extend 
over the same set of columns, as in the example below. 

 If you want a row or column of numbers to be 
used as legends or axis labels and not as data to 
be plotted, be prepared for some extra work so the 
Wizard understands what you want.  

In the example data, we'll want to use the Year column as 
category (x-axis) labels. One possible workaround, as 
illustrated below, is simply to avoid using pure numbers for 
row or column headings. In this case, editing the Year 
column so it reads 1991/2, 1993/4 etc. ensures that it won't 
be treated as a data series. Alternatively, take action at Step 
2 of the Chart Wizard process - see the next page. 

 To select non-adjacent rows or columns:  
keep the Ctrl key (bottom left or right of 
keyboard) held down while you click and drag 
over the areas you want to select.  

 Try this out by selecting the data for a chart to 
show the proportion of mature students at 
Sheffield Hallam University 1991-1997. 

What you have highlighted for charting should look like the 
illustration. Don't be confused if the first cell of the last group you 
highlighted  doesn't look as if it has been selected.  
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3. Conjure up your Chart 

 Check you have selected your data correctly (page 23). 

 In the Toolbar, click on the Chart Wizard tool. 

Chart Wizard Step 1 

 Select the Chart type you want. 

From the many chart types to choose from, only one or two are 
likely to be appropriate for your particular data. For numerical or 
scientific line graphs, “XY Scatter” may be a better choice than 
“Line”. The Line type won’t use variable x axis values.  

 Select the Chart sub-type you want. Read the 
description which appears at the bottom for the 
highlighted item. Be clear about the differences – for 
instance, between stacked and clustered columns. 

3-D graphs are excellent for giving a quick visual impression, but 
may be hard to interpret for “heavyweight” scientific data. 

 Click "Press and hold to view sample". 

What you see now in the sub-type window should chart the data as 
you want. Check that the correct data has been charted, but don't 
worry at this stage if the axis labels or legends aren't formatted as 
you want, or if the chart looks completely the wrong shape. 

 If you realise you've selected your data incorrectly, you may 
find it easiest to Cancel and start again. Alternatively, carry 
on and reselect your data at Step 2. 

Chart Wizard Step 2 
 To make changes to the data range selected: click on the 
red arrow by the Data range box. Reselect your data, 
then click the red arrow again to return to the Wizard. 

 Click on the Series tab to see exactly how Excel is 
using your data. If the Wizard hasn't interpreted 
correctly which rows or columns are data series, and 
which are category axis labels, you will need to make 
changes from here. Click on the red arrow by Category 
(X) axis labels, select the required data, then click the 
red arrow again to return to the Wizard. Note: if the row 
or column containing this data has a heading cell (Year 
in our example) make sure that this cell isn't selected. 
You will also need to remove this data range from the 
series picklist. 
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Chart Wizard Step 3 

This is where you set a variety of chart options. 

 Add a title for your chart. Don't worry if 
it isn't positioned correctly, or is too large 
or small – you can alter this later. 

 Click on the other chart options tabs to see 
what you can alter. From Legend, you 
can change the positioning of your legend 
in relation to the chart. Click Data 
Labels if you want to show values in 
figures on your chart; Data Table if you 
want to display the chart data in table 
form underneath it. 

Chart Wizard Step 4 

Specify whether to put your chart on its own separate 
worksheet within the workbook, or as an object in the 
current worksheet. See page 23. 

 Make your choice, then click on Finish. 

Your chart will now appear. In Excel 2002/3, the Chart Toolbar 
will also pop up - see page 26.  

 

Moving and resizing your chart 

 To move your chart: move the mouse cursor until 
it's over a blank area of the chart. Check that the 
yellow tool tip box which appears says Chart 
Area, otherwise your actions will only apply to a 
specific object within the chart. Click and drag to 
move – when you start dragging, the cursor will 
change to a move symbol, as illustrated. 

 To resize your chart: click in a blank area of the 
chart to select the whole chart area. Small black 
handles will appear at the corners of the chart 
area. Move the mouse over a corner handle until 
it's a two-way arrow shape, then click and drag. If 
you click and drag on side handles, the chart will 
be stretched or shrunk in that direction. When you 
do this, axis labels etc. will be automatically 
reformatted to best suit the new size. 

 Within your chart, you can independently move and 
resize title, legend and plot area in the same way. 
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Changing Chart Data 

To edit your chart title: just click within it and type as usual. You 
can't do this with legends or axis labels –these values are supplied by 
their related data cells on the spreadsheet. 

X-axis labels have updated 
automatically 

Your chart is actively linked to the data it was created from. As soon 
as you correct or change any data contained in the cells selected for 
charting, the chart will be updated automatically. In our example, you 
might decide that your x-axis labels would look better if you changed 
your row headings to "91/92" instead of "1991/92", and so on.  

 Click to make cell A4 the active cell. Change so it reads 
91/92, and treat cells A5 – A10 similarly. 

 Look at the chart again. The x-axis labels have been updated. 

Adding a data series to your chart 

After you have created a chart, you can instantly add data 
series, without having to repeat the whole Chart Wizard 
process. In the example, you might want to change the chart 
to show numbers of women as well as mature students. 

 Select the data you want to add to the chart. 
 Move the mouse over the border of the selected cells 
until its shape changes to a move cursor (see page 11), 
then drag and drop  into the chart. Magic! 

Deleting a data series from your chart 
 In your chart, single-click anywhere on the data series you 

want to delete to select it. Press the Delete key. The data 
from which the chart was generated will not be affected. 

Formatting chart objects 

The different components which make up a chart 
– Title, Legend, Axis, Data Series and so on – are 
referred to in Excel as chart objects. You may 
want to make formatting changes to any of these 
objects. In Excel 2002/3, this can be done from 
the Chart Toolbar. It should pop up whenever a 
chart is selected. If not: from the View menu, 
select Toolbars, then Chart. 

The Excel 2002/3 Chart Toolbar. From the 
picklist, select the Chart Object you want to 
reformat; then click the format button. From 
this toolbar you can also add a copy of the 
chart data underneath your chart, and even 
instantly change your Chart Type. 

In Excel 97/2000, double-click on any chart object to open the 
relevant formatting dialog box; or right-click on it, then select the 
Format option from the shortcut menu. These methods can also still 
be used in 2002/3: double-clicking is often quicker than using the 
Chart Toolbar. Keep your eye on the yellow tool tips box to ensure 
that the selected chart object is the one you want to change. 
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Using the chart formatting dialog boxes 
 Select the chart object you want to reformat and 

open the formatting dialog box as described on 
the previous page. The options available from the 
dialog box will vary depending on the type of 
object you have selected. 

 The Format Chart Area dialog box is 
illustrated, with the Patterns tab selected. From 
here, the colour or fill effects you select will be 
applied to the chart's background area. Changes 
you make from the Font tab will be applied 
globally to all chart objects. To change font style 
or size for a specific chart object (for example 
title, axis or legend): select the object before you 
double-click so the appropriate dialog box opens. 

Formatting data series 

 Double-click on one of your data series to open the Format 
Data Series dialog box. You will need to repeat the 
process for each of the series in your chart. 

 Patterns are especially useful for applying to data series 
when you're printing on a black-and-white printer. From the 
Patterns tab, select Fill Effects, then Pattern. Notice 
that if you want, you can even use pictures as a fill – but if 
you do, you may find things run very slowly! 

 Other items available from the Format Data Series dialog 
box can be very useful. From the Data Labels tab, you can 
select settings to print the actual figures as labels on your 

data series. Series order lets you switch around the order of the 
data series as they appear on your chart. From options, you can 
specify overlap and gap width between columns, or make similar 
kinds of adjustment to other types of chart. 

 

Formatting axis lines and text 

Excel refers to the two axes of a chart as category (usually the 
x-axis, running across) and value (usually the y-axis, running 
up). You must format each axis separately.  

 From Patterns, set the weight and style of the axis line. 
 From Scale, set the units used on the axis. If, for instance, 

Excel has chosen units of 100 on the y-axis and you want 
units of 50 instead, change it from here. 

 From Number, set any special formatting you want. For 
instance, you might want £ signs on your axis numbers. 

 From Alignment, change the orientation of your axis labels 
– they can run at any angle you want. 
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Viewing and Printing your work 

Zooming 

While you’re working, you can view your spreadsheet at whatever 
magnification is convenient to you. Zooming has no effect on how 
your work looks when it’s printed. 

 In the Toolbar, click the arrow by the Zoom box. 
It’s often useful to select the area you want to view, and then choose 
the Selection zoom –  this will fit the whole area selected onto the 
screen. At a low magnification, note that screen display may not be 
accurate. 

Printing Do's and Don'ts 

 
You don’t have to worry too much about the size of 
the printed page while you’re working on an Excel 
worksheet: Excel will let you scale your spreadsheet to fit 
the printed page. However, it's best to use type sizes which 
mean that drastic scaling isn't required. 

 Don’t print until you have followed the steps below.  
1. If more than one printer is available, select the one you 

want before previewing - change from File | Print.  
2. If you want to print only part of a worksheet, Set 

Print Area before previewing. See below. 
3. Always check thoroughly in Print Preview before 

printing. This is important - unless you have made 
appropriate Page Break and Page Setup choices, you may 
find that columns are split across two pages, rather than 
all fitting within one page. 

Selecting part of a worksheet for printing 

 If you want a single chart to occupy a full page, select just 
the chart, and this will be what Excel gives you automatically. 
Go straight to Print Preview – see the next page. 

For any other selection: 
 Select the area of the worksheet which you want to print. 

This can include any mixture of charts and data, provided that 
they are adjacent and can be selected "all in one". 

 From the File menu, select Print Area, then choose Set 
Print Area. 

 Return to the Print Area menu item to Clear the Print Area 
when you have finished printing the required selection. 
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Using Print Preview 

Always use Excel’s Print Preview facility to check 
your selection, layout and formatting before 
sending your work to the printer. 

 If you want to print only a selection from your worksheet area, 
follow the instructions in the previous section first. 

 From the File menu, select Print Preview (or click the 
Toolbar button). 

What you see on screen will be the first page of your printout. 
 Check the page looks as you expect. Look at the bottom left of 

the preview window to check that the printout will consist 
only of the number of pages you anticipated. If columns or 
rows are overflowing onto extra pages, you'll need to use Page 
Setup to switch page orientation and/or scale to fit. 

Always check that total number 
of pages is as you expect. 

 Look at the controls at the top of the preview window: 

 Use Next and Previous to move between pages. (You can 
also do this with the Scroll bar on the right of the window.)  

 Zoom takes you between a whole-page view, and homing in 
on a particular area. Click while the mouse cursor is a 
magnifying glass shape to “home in”, and click again to return 
to the whole page view.  

 The Print button takes you straight into the Print dialog box – 
make sure you've got everything as you want first. 

 Setup opens the Page Setup dialog box. See the next page. 
Margin handles Column handles  Click on the Margins button if you want to alter these from 

Print Preview. When the black margin handles are visible, 
click and drag to reposition them. Note that you can change 
column widths from here too. Changes you make to margin 
and column settings from Print Preview will apply to all the 
pages in a multi-page printout. 

 Use Page Break Preview to alter where rows and columns 
break across pages. Excel will automatically apply scaling as 
necessary once you have done this. Click and drag on the 
blue dashed lines to make your changes. Use the View menu 
if you want to switch back from here to normal spreadsheet 
view. 

 The Close button returns you from Print Preview to the 
normal editing mode. If you have been using Page Break 
Preview, a Normal View button will have appeared when 
you return to print preview. Use instead of Close to return to 
normal editing mode. 
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Page Setup 

In Excel, Page Setup dictates how your spreadsheet will look printed 
out, not how it looks on screen. You can scale to fit the printed page; 
change orientation to print portrait (the usual tall and thin) or 
landscape (short and wide); print with or without gridlines showing 
round each cell; set margins from here; and include Headers and/or 
Footers (including file name and page numbers) on every sheet. 

 In the Print Preview toolbar, click the 
Setup button. Alternatively, you can 
make changes before previewing: from 
the File menu, select Page Setup.  

 Click the Page tab to change 
Orientation and Paper size. Paper size 
must correspond to what the printer uses. 
You can Scale so that your work prints at 
whatever % you want of its actual size. 
Fit To is very often useful to scale down 
your work so that it will fit exactly to the 
paper size being printed on. If you want 
page numbers starting other than at 1, 
enter the required starting number in the 

First Page Number box. 
 From the Margins tab, Centre on Page is a useful option. If 

you want to change the positioning of headers and footers in 
relation to the page, you also do this from here. You may 
prefer to alter the margins themselves from Print Preview: it’s 
much easier to see what the effect will be. 

 Click the Header/Footer tab if you want to add page 
numbers or any other information on every page. Excel offers 
you a range of preset ways to combine page number and 
filename information in your headers and footers – click on 
the arrow by the Header or Footer box to choose from the 
picklist. You can add your own Custom Headers and Footers 
if you wish. 

 From the Sheet tab, the setting you’ll most often want to 
change is Print Gridlines –  the default is usually set so that 
gridlines don't print, but you'll often want them. If you check 
Row and Column Headings, cell reference numbers will be 
printed – any headings you've added within the worksheet will 
print without this option being checked. 

Printing 
 In Print Preview mode, click on the Print button to open the 

Print box. You can set number of copies, and the range of 
pages you want printed, from here. With a multi-page job, it’s 
always a good idea to print out just one page first to check. If 
you use the toolbar Print button when you aren't in Preview 
mode, a single copy of all pages will be sent straight to the 
printer –  you won’t be able to specify anything different. 
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Importing, exporting, copying & pasting 

Copying and pasting between Excel and Word 
Data can easily be transferred as a table from Excel into Word.  

 In Excel, select the cells you want to copy, and click the 
Copy button on the toolbar. Don't be tempted to press Escape 
to get rid of the shimmering lines which appear –  you won't 
be able to paste if you do. 

 Switch to Word, and paste. Your spreadsheet data will now 
appear as a Word table. You may need to adjust column 
widths and text alignment. The Table menu Autofit 
capabilities are useful.  

Pasting a Word table into Excel is equally simple. Charts need 
handling a little more carefully.  

Word 97/2000: To paste a 
chart as a picture: don't use 
the Paste button. From the 
Edit  menu, select Paste 
Special, then choose Picture 
format. 

 Before copying, resize your chart to roughly the size you want. 

 In Word 2002/3, by default your chart will be pasted into 
Word as a bitmap picture. This avoids the risks of unexpected 
changes in the formatting of the chart which may arise if it is 
pasted as an editable Excel object. 

Transferring data to and from Access 
Pasting data from Access into Excel is straightforward. When you 
paste data from Excel into Access, Access will automatically set up a 
new table within this database and place the data within it. Rename 
this new table as you wish, and open it in the usual way. 

Incorporating pictures in an Excel worksheet 

You can use Microsoft's drawing tools to create drawings or diagrams 
on an Excel worksheet in just the same way as you can in Word. 

 In the Toolbar, click the Drawing icon. The drawing toolbar 
will open at the bottom of the window.  

 Drawing objects which you have created in Word should copy 
and paste into Excel without any problems. 

You can include a company logo, or any other image saved in a 
bitmap format (for example .jpg, .gif, .bmp, .tif) on your worksheet. 
Don't copy and paste bitmap images into Excel – it may 
make your file many times larger than it needs to be. 

 From the Insert menu, select Picture, then From File.   
The companion document, Making IT happen with MS Word, 
includes guidance on using Office drawing tools, and on how to 
handle bitmap images in Office software. 
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Exporting spreadsheets in simple text format 

Any simple numerical or text data which has 
been laid out in tabular format – whether it's a 
table in Word, a spreadsheet in Excel, or a 
database table in Access – can be saved in a 
delimited text format. This is an approach which 
is often used when any kind of table data needs to 
be saved in a format which can be understood by 
any text or data processing software running on 
any operating system. Cells are separated from 
one another by a specified character – usually a 
comma or a tab. 

 Place the data you want to export on a separate worksheet. 

 From File | Save As, select Text (Tab delimited) or CSV 
(Comma delimited – CSV is short for Comma Separated 
Values). You will be reminded that only the active sheet will 
be saved, and that some Excel features will not be compatible 
with this format. OK to carry on.   

Table data saved from any software in any delimited format can be 
imported into Excel. 

Above: The sample "Student 
Stats" data saved in CSV 
format and displayed in 
Notepad. Inverted commas 
have been added 
automatically around the 
column where numbers had 
been formatted with commas 
to separate thousands. This is 
to distinguish those commas 
from the ones which separate 
each cell. 

 From File | Open, set Files of Type to All Files. You will 
now see all files listed regardless of their file extension – 
select your file. 

 If Excel isn't completely clear about the file format, a Text 
Import Wizard will appear to guide you through the 
necessary choices. 

Saving data as HTML 
You can convert all or part of an Excel worksheet, including charts, 
into html format so that it can be displayed on Web pages: 

 If you want just a part of your data saved in html format, select 
it first. From the File menu, select Save as Web Page. Make 

sure that you click the Selection button if 
you don't want the entire file to be converted. 

Any charts you have included will be converted into GIF bitmap 
files, and placed in a folder with the same name as your html file. 
This can be a useful way of converting charts to image files, even if 
your reason for wanting to do this isn't for use in Web pages! 

Excel 97: "Save as HTML"  
calls up an Internet Assistant 
Wizard. Office XP (2002) 
software introduced significant 
changes in html capabilities. 
Excel 2000 comes somewhere 
between the two. 

Be cautious when you save as html from any Microsoft Office 
software – your html files will be unnecessarily large, and may not 
view correctly on all browsers. For serious Website production, save 
your spreadsheet from Excel as tab-delimited text, then import 
into Dreamweaver using the import tabular data option. 
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References and Further Reading 

Companion documents to this one include: 

Making IT happen with MS Word 

Making IT happen with MS Access 

 

If you've understood how to use the features described here, you 
should be able to learn for yourself from online help about Excel's 
other capabilities which haven't been covered. Features which you 
may want to investigate include: 

 "What if" analysis: Excel offers a variety of statistical analysis 
tools, including data table, scenarios, goal seek, and solver. 

 Validating cell entries: especially important if you're 
designing a spreadsheet for others to enter data in. 

 Data summaries and analysis: use a pivot table and/or Excel's 
outline tools for this. 

 Consolidating data from multiple tables. 

 Worksheet protection.  

 Saving display and print settings as views for future use. 

 Creating macros for automating tasks. 
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DOCUMENT CROSS-
REFERENCE TO 
EUROPEAN COMPUTER 
DRIVING LICENCE (ECDL) 
SYLLABUS  
 
The ECDL is an internationally accepted 
certificate of computing competence. The 
purpose of the table below is to set out 
what ECDL Database module 
requirements are; and to indicate how the 
content of this document maps to these 
requirements. This document can be 
used as a supplement to ECDL 
learning materials, but not as a 
replacement. You need experience in 
traffic before you can pass a driving test; 
in the same way you'll need practical 
experience of working with a fairly 
substantial spreadsheet. Items are 
marked with an asterisk * where this is 
particularly important to bear in mind. 
ECDL "Getting started" basics which are 
the same in any Windows software are 
not repeated in this document. Some 
topics are covered in greater depth here 
than is required by the ECDL syllabus. 
This applies particularly to using formulae 
and functions, and to Excel's list-handling 
capabilities. 
 
4.1 Getting Started  
4.1.1 First Steps with Spreadsheets  
4.1.1.1 Open a spreadsheet 
application. 

 

4.1.1.2 Open an existing 
spreadsheet – make some 
modifications and save. 

 

4.1.1.3 Open several spreadsheets.  
4.1.1.4 Create a new spreadsheet 
and save. 

 

4.1.1.5 Save an existing 
spreadsheet onto the hard disk or 
diskette. 

 

4.1.1.6 Close the spreadsheet.  
4.1.1.7 Use application Help 
functions. 

5 

4.1.1.8 Close the spreadsheet 
application. 

 

4.1.2 Adjust Basic Settings  
4.1.2.1 Change spreadsheet view 
mode. 

29 

4.1.2.2 Use the page view 
magnification tool / zoom tool. 

28 

4.1.2.3 Modify toolbar display.  
4.1.3 Document Exchange  
4.1.3.1 Save an existing 
spreadsheet under another file 
format 

5,32 

4.1.3.2 Save a document in a format 
appropriate for posting to a Website. 
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4.2 Basic Operations  
4.2.1 Insert Data  
4.2.1.1 Enter numbers in a cell. 6 
4.2.1.2 Enter text in a cell. 6 

4.2.1.3 Enter symbols or special 
characters in a cell. 

6 

4.2.1.4 Enter simple formulas in a 
cell. 

6 

4.2.1.5 Use the undo command. 6 
4.2.2 Select Data   
4.2.2.1 Select a cell or range of 
adjacent or non-adjacent cells. 

9 

4.2.2.2 Select a row or column. 
Select a range of adjacent or non-
adjacent rows or columns. 

9 

4.2.3 Copy, Move, Delete  
4.2.3.1 Use the Copy and Paste 
tools to duplicate cell contents in 
another part of a worksheet. 

10 

4.2.3.2 Use the Cut and Paste tools 
to move cell contents within 
worksheet. 

10 

4.2.3.2 Move cell contents between 
active worksheets. 

11 

4.2.3.4 Move cell contents between 
active spreadsheets. 

10 

4.2.3.5 Delete cell contents in a 
selected cell range. 

10 

4.2.4 Search and Replace  
4.2.4.1 Use the search command for 
specified cell content. 

 

4.2.4.2 Use the replace command 
for specified cell content. 

 

4.2.5 Rows and Columns  
4.2.5.1 Insert rows and columns. 11 
4.2.5.2 Modify column width and row 
height. 

9 

4.2.5.3 Delete selected rows or 
columns. 

10 

4.2.6 Sort Data   
4.2.6.1 Sort selected data in 
ascending or descending numeric 
order. 

21 

4.2.6.2 Sort selected data in 
ascending or descending alphabetic 
order. 

21 

4.3 Formulas and Functions  
4.3.1 Arithmetic and Logical 
Formulas 

 

4.3.1.1 Use basic arithmetic and 
logical formulas in a spreadsheet . 

6,15 

4.3.1.2 Recognise standard error 
messages associated with formulas. 

 

4.3.1.3 Use the autofill tool/copy 
handle tool to copy or increment 
data entries. 

7,16 

4.3.1.4 Understand and use relative 
cell referencing in formulas or 
functions. 

16 

4.3.1.5 Understand and use absolute 
cell-referencing in formulas or 
functions. 

16 

4.3.2 Working with Functions  
4.3.2.1 Use the sum function. 15,16 
4.3.2.2 Use the average function. 16,17 
4.4 Formatting  
4.4.1 Format Cells - Numbers  
4.4.1.1 Format cells to display 
different number styles. 

13 

4.4.1.2 Format cells to display 
different date styles. 

13 

4.4.1.3 Format cells to display 
different currency symbols. 

13 

4.4.1.4 Format cells to display 13 

numbers as percentages, 
4.4.2 Format Cells - Text  
4.4.2.1 Change text size. Format 
text: bold, italic, font type. 

13 

4.4.2.2 Change text font colour. 13 
4.4.2.3 Adjust text orientation. 14 
4.4.3 Format Cells – Cell Ranges  
4.4.3.1 Centre and align cell 
contents in a selected cell range: left 
and right, top and bottom. 

9 

4.4.3.2 Add border effects to a 
selected cell range. 

14 

4.4.4 Spelling  
4.4.4.1 Use a spell-check program 
and make changes where 
necessary. 

 

4.4.5 Document Setup  
4.4.5.1 Modify document margin 
settings. 

30 

4.4.5.2 Adjust document setup to fit 
one page. 

30 

4.4.5.3 Add a Header and Footer. 30 
4.4.5.4 Change document 
orientation – portrait or landscape, 
page size etc. 

30 

4.5 Printing   
4.5.1 Printing simple spreadsheet 
documents 

 

4.5.1.1 Use basic print options. 28 
4.5.1.2 Preview a spreadsheet. 29 
4.5.1.3 Print a spreadsheet or a 
worksheet. 

30 

4.5.1.4 Print part of a worksheet or a 
pre-defined cell range. 

28 

4.6 More Advanced Features  
4.6.7 Importing Objects  
4.6.1.1 Import objects into a 
spreadsheet: image files, graphs, 
text files etc. 

31,32 

4.6.1.2 Move and resize imported 
objects within a spreadsheet. 

 

4.6.2 Charts and Graphs  
4.6.2.1 Produce different types of 
charts and graphs from spreadsheet 
figures to analyse data. 

22-27 

4.6.2.2 Edit or modify a chart or 
graph. 

26-27 

4.6.2.3 Change the chart type. 26 
4.6.2.4 Move and delete charts or 
graphs. 

25 
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Absolute cell references 16 
Access, transferring data 32 
Address bars 9 
Alignment 9,14 
Arguments 15 
AutoFill 7 
AutoFill, using with 
formulae  and functions 16 
AutoFormat 14 
AutoSum  16 
Borders, adding 14 
Cells 4 
Character formatting 13 
Chart data, changing 27 
Chart formatting, 26 
Chart types 24 
Charts, editing 27 
Charts, resizing 25 
Column widths, adjusting 9 
Copying a range of cells 10 
Data series 22 
Databases 19 
Deleting data 10 
Do's and Don'ts 8 
Displaying Formulae 18 
Filtering lists 21 
Formatting numbers 13 
Forms 20 
Formula Bar 6 
Formulae 15-17 
Formulae, displaying 18 
Functions, specialist 17 
Gridlines, printing 14 
Headers & Footers 30 
Headings, centering 9 
Help 5 
HTML, saving as 32 
IF statements 18 
Inserting cells 11 
Leaving Excel 5 
Labels 22 
Legends 22,26 
Lists 19 

Margins 30 
Moving cells 11 
Naming files 8 
Numbers, formatting 13 
Page Break Preview 29 
Page Setup 30 
Parentheses 15 
Pictures, inserting 31 
Print Preview 29 
Printer Setup 28 
Printing 30 
Relative & Absolute  
   cell references 16 
Row height, adjusting 9 
Saving a spreadsheet as a  
different  file type 5,32 
Select, then Do 9 
Selecting print area 28 
Sorting lists 21 
Status Bar 4 
Sum 15 
Text Alignment 13,14 
Tool tips 4 
Transferring data 31-32 
Typeface and Typesize 13 
Undoing 6 
Word, transferring data 31 
Workbook 4 
Worksheets 5,12 
Zooming 28 
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